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CPU​          ​ Central Processing Unit 

ALU​         ​ Arithmetic Logic Unit 

CU​          ​ Control Unit 

ICT​          ​ Information Communication Technology. 

HMIS​        ​ Health Management Information System 

LAN​         ​ Local Area Network 

HDD​        ​ Hard Drive Disk 

DOS​         ​ Disk Operating System 

GUI​         ​ Graphical User Interface 

NLM​        ​ National Library of Medicine 

CDSR​      ​ Cochrane Database of Systematic Reviews 
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Preamble 

 

The Ministry of Health Community Development Gender Elderly and Children among other roles 

ensures that Tanzanians receive quality health care and service. This can be achieved through 

production of competent nurses and midwives amongst other health cadres. The training of competent 

nurses and midwives can be achieved through various teaching and learning materials; one of them being 

facilitator’s guides and student’s manual.  
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Background 

In 2015 the Ministry of Health, Community Development, Gender, Elderly and Children through the 

Directorate of Human Resource Development, Nursing training section started the process of reviewing 

the nursing curricula NTA level 4-6. The process completed in the year 2017 and its implementation 

started in the same year. The rationale for review was to comply with the National Council for Technical 

award (NACTE) Qualification framework which offers a climbing ladder for higher skills opportunity. 

Amongst other rationale was to meet the demand of the current health care service delivery. The 

demand is also aligned with human resource for health strategic plan and human resource for health 

production plan which aims at increasing number of qualified human resource for health. 

 

The process of producing qualified human resource for health especially nurses and midwives requires 

the plentiful investment of resources in teaching at the classroom and practical setting and the 

achievement of clinical competence is acquired in step wise starting from classroom teaching to skills 

laboratory teaching. In addition, WHO advocates for skilled and motivated health workers in producing 

good health services and increase performance of health systems (WHO World Health Report, 2006). 

Moreover, Primary Health Care Development Program (PHCDP) (2007-15) needs the nation to 

strengthen and expand health services at all levels. This can only be achieved when the Nation has 

adequate, appropriately trained and competent work force who can be deployed in the health facilities 

to facilitate the provisions of quality health care services. 

 

In line with the revised curricula, the MOHCDGEC in collaboration with developing partners and team of 

technical staff developed quality standardized training materials to support the implementation of 

curricula. These training materials address the foreseen discrepancies in the implementation of the 

curricula by training institutions.  

 

This facilitator’s guide has been developed through a series of writers’ workshop (WW) approach. The 

goals of Writer’s Workshops were to develop high-quality, standardized teaching materials and to build 

the capacity of tutors to develop these materials.  This module consists of 10 sessions which aimed at 

equipping learners with basic computer knowledge skills.  

 

1.0.​ Rationale 

The vision and mission of the National Health Policy in Tanzania focuses on establishing a health 

system that is responsive to the needs of the people, and leads to improved health status for all.  

Skilled and motivated health workers are crucially important for producing good health through 

increasing the performance of health systems (WHO, 2006). With limited resources (human and 

non-human resources), the MOHCDGEC supported tutors by developing standardized training 

materials to accompany the implementation of the developed CBET curricula. These training manuals 

address the foreseen discrepancies in the implementation of the revised curricula. 

 

Therefore, this Facilitators Guide for Basic Technician Certificate in Nursing and Midwifery Programme 

(NTA Levels 4) aims at providing a room for Nurses to continue achieving skills which will enable them 

to perform competently. This Guide will establish conducive and sustainable training environment that 

will allow Facilitator to interact effectively with learners, in turns  learners and graduates will perform 

efficiently at their relevant levels. Moreover, this will enable them to aspire for attainment of higher 

knowledge, skills and attitudes in promoting excellence in nursing and midwifery practice. 
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2.0.​ Goals and Objectives of the Training Manual 

2.1.​ Overall Goal for Training Manual 

The overall goal of these Facilitators’ Guides is to provide high quality, standardized and 

Competence based training for Basic Technician Certificate in Nursing and Midwifery. 

 

2.2.​ Objectives for Facilitators Guides 

•    To provide high quality, standardized and competence based training. 

•    To provide a guide for Facilitators to deliver high quality training. 

•    To enable learners to learn more effectively. 

 

3.0.​ Introduction 

3.1.​ Module Overview 

This module content has been prepared as a guide for tutors of NTA Level 4 for training students. The 

session contents are based on the sub-enabling outcomes of the curriculum of NTA Level 4 Basic 

technician Certificate in Nursing and Midwifery. 

 

The module sub-enabling outcome as follows: 

5.1.1​ Describe components and accessory of a computer and their functions in relation to basic 

computer operations 

5.1.2​ Perform basic computer operations using knowledge and skills of computer technology  

5.1.3​ Utilize word processing application in preparing reports 

5.1.4​ Utilize spread sheet application in processing health data 

5.1.5​ Utilize power point application in preparing health information presentations 

5.1.6​ Utilize Microsoft publisher application in preparing health publications 

5.1.7​ Utilize Microsoft access application in keeping health data 

5.1.8​ Communicate and search health information using basic computer operation 

3.2.​ Who is the Module For? 

This module is intended for use primarily by Facilitators of NTA Level 4 –Basic Technician Certificate in 

Nursing and Midwifery 

The module’ sessions give guidance on the time and activities of the session and provide information 

on how to teach the session to students.  The sessions include different activities which focus on 

increasing students’ knowledge, skills and attitudes. 

 

3.3.​ How is the Module Organized? 

The module is divided into 10 sessions; each session is divided into sections. The following are the 

sections of each session: 

●​ Session Title: The name of the session. 

●​ Learning Tasks – Statements which indicate what the student is expected to learn at the end of the 

session. 

●​ Session Content – All the session contents are divided into steps. Each step has a heading and an 

estimated time to teach that step.  Also, this section includes instructions for the tutor and activities 

with their instructions to be done during teaching of the contents. 

●​ Key Points – Each session has a step which concludes the session contents near the end of a 

session.  This step summarizes the main points and ideas from the session. 

●​ Evaluation – The last section of the session consists of short questions based on the learning 

objectives to check the understanding of students. 
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●​ Handouts and Worksheets are additional information which can be used in the classroom while 

teaching or later for students’ further learning and doing assignment.  Handouts are used to provide 

extra information related to the session topic that cannot fit into the session time.  Handouts can be 

used by the students to study material on their own and to reference after the session. Sometimes, a 

handout will have questions or an exercise for the students.  The answers to the questions are in the 

Facilitator Guide Handout, and not in the Student Manual Handout. 

 

3.4.​ How Should the Module be Used? 

Learners are expected to use the module in the classroom and clinical settings and during self-study.  

The contents of the modules are the basis for learning Basic Computer Applications. Learners are 

therefore advised to learn each session and the relevant handouts and worksheets during class hours, 

clinical hours and self-study time.  Facilitators are there to provide guidance and to respond to all 

difficulty encountered by students. 
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SESSION 1:​  INTRODUCTION TO COMPUTER COMPONENTS  

 

Total Session Time:​60 minutes 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time (min) Activity/​
Method 

Content 

1 05  Presentation Presentation of session title and learning tasks 

2 10 Presentation, 

/Brainstorming 

Definition of the term computer 

3 15 Lecture Discussion Characteristics of a computer 

4 05 Presentation, Buzzing classification of computer by size and power 

5 15 Presentation/Lecture 

Discussion 

main parts of the computer(process, input, output 

storage 

6 05  Presentation Key Points 

7 05  Presentation Session Evaluation 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 
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STEP 2: Definition of the term computer (10 Minutes) 

 

 

 

 

 

●​ A computer is an electronic device that stores, retrieves, and processes data, and can be 

programmed with instructions.  

●​ It’s designed to perform arithmetic and logical operations automatically  

STEP 3: Characteristics of a computer (15 Minutes) 

 

 

 

 

 

●​ Speed: - 

o​  A computer is very fast device. It can perform large amount of work in a few seconds. 

o​  Where human being worked a particular work for whole day, computer does the same in very 

short time.  

o​ Today, computers can perform 100 million computations in one second.  

o​ The speed of computers is measured in terms of microseconds, Nano seconds and even inPico 

seconds.  

 

●​ Accuracy: –  

o​ The computer is 100% accurate and capable to perform arithmetical calculation and logic 

operations with the same accuracy.  

o​ It can never make mistakes. All mistakes are done by users.  

o​ The cause of errors may be due to inaccurate feeding data or due to wrong setting of the 

programmer.  

●​  Diligence: –  

o​ A computer can operate twenty four hours continuously without taking any rest. It has no 

feelings or no emotions, if you work continuously for 3 hours, you feel lack of concentrate but a 
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computer is free from these and you will get the result you want with the same speed and same 

accuracy. 

 

●​ Versatility: –  

o​ Versatility is one of the most wonderful features about the computer. One moment, it is 

preparing the results of a particular examination, the next moment it is busy in preparing 

electricity bills, and in between it may be helping an office secretary to trace an important letter 

is seconds.  

o​ It can do multiple works at a same time.  

o​ It also used in data processing jobs, weather fore casting, ticket reservation purpose, 

multimedia designing, animations, accountancy etc. 

 

●​ High Memory: – 

o​ computer has made more memory or storage capacity than human beings.  

o​ It can store millions of data and instructions, which can be retrieved and recalled even after a 

number of years. This is not possible in case of human brain.  

 

●​ Automation: – 

o​ Computers are automatic in operation. 

o​ It means once the data and instructions are fed to a computer, human interventions are not 

required.  

o​ The computers manipulate the data according to the instructions and continue doing so till the 

last instruction is executed. 

 
 STEP 4: Classification of Computer by Size and Power (5 Minutes) 

 

●​ Computer can be classified as:- 

o​ Micro-computers 

o​ Minicomputers 

o​ Mainframe computer 

o​ Supercomputers 

 

Micro-computer 

o​ Microcomputers are the most frequently used type of computer. Also, known as Personal 

Computer (PC), 

o​ A microcomputer is a small computer system designed to be used by one person at a time.  

o​ The size of microcomputers range from those that can fit on a desktop, inside a briefcase, or 

even into a shirt pocket.  

o​ The various sizes of microcomputers can be grouped into desktop computers and portable 

computers. 
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   Source: https://ziglinkit.com/classification-of-computers/ 

 

Minicomputer. 

o​ Minicomputers are much smaller than mainframes and are also less expensive.  

o​ Sometimes referred to as Midrange Server or Midrange Computer, they are typically larger, 

more powerful and more expensive than desktop computers.  

o​ Midrange computers are usually used by small and medium-sized businesses as their servers. 

 

                           

Source: https://ziglinkit.com/classification-of-computers/ 

 

Mainframe computer. 

o​ Mainframe computers are very large often filling an entire room and can process thousands of 

millions of instructions per second.  

o​ They are used in large private and government organizations like insurance companies and 

banks where many people need frequent access to information.  

o​ In a mainframe environment, users connect to the mainframe through the many terminals wired 

to the mainframe.  

o​ Mainframes are capable of supporting hundreds to thousands of users simultaneously. Some of 

the functions performed by a mainframe include: flight scheduling, reservations and ticketing for 

an airline; government agencies such as the Internal Revenue Service, Electoral Commission. 
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Source: https://ziglinkit.com/classification-of-computers/ 

 

Supercomputer. 

o​ Supercomputers are the most powerful and physically the largest by size.  

o​ These are systems designed to process huge amounts of data and the fastest supercomputers 

can perform over one trillion calculations in a second.  

    

                    

Source: https://ziglinkit.com/classification-of-computers/. 

 

 

STEP 5: Main Parts of the Computer(process, input, output storage (15 Minutes) 

●​ The basic components of computer system are:- 

o​ Input Unit 

o​ Output Unit. 

o​ Central Processing Unit. 

o​ Storage Unit. 

 

Input Unit 

●​ Input devices are the devices which are used to feed programs and data to the computer.  

●​ The input system connects the external environment with the computer system.  
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●​ The input devices are the means of communication between the user and the computer system. 

●​ Typical input devices include the keyboard, floppy disks, mouse, microphone, light pen, joy stick, 

magnetic tapes etc.  

●​ The way in which the data is fed into the computer through each of these devices is different.  

●​ However, a computer can accept data only in a specific form.  

●​ Therefore these input devices transform the data fed to them, into a form which can be accepted by 

the computer.  

●​ These devices are a means of communication and inter 1 station between the user and the 

computer systems. 

  

The functions of the input unit are:- 

o​ Accept information (data) and programs 

o​ Convert the data in a form which the computer can accept. 

o​ Provide this converted data to the computer for further processing. 

 

 

o​ The Output Unit   

▪​ The output devices give the results of the process and computations to the outside world.  

▪​ The output units accept the results produced by the computer, convert them into a human 

readable form and supply them to the users.  

▪​ The more common output devices are printers, plotters, display screens, magnetic tape 

drives etc. 

 

o​ The Central Processing Unit. 

▪​ This is the brain of any computer system. The central processing unit or CPU is made of 

three parts:- control unit and arithmetic logic unit 

 

The control unit 

▪​ The Control Unit controls the operations of the entire computer system.  

▪​ The control unit gets the instructions from the programs stored in primary storage unit 

interprets these instruction an subsequently directs the other units to execute the 

instructions. 

▪​ Thus it manages and coordinates the entire computer system. 

 

The Arithmetic Logic Unit:- 

▪​ The Arithmetic Logic Unit (ALU) actually executes the instructions and performs all the 

calculations and decisions.  

▪​ The data is held in the primary storage unit and transferred to the ALU whenever needed.  

▪​ Data can be moved from the primary storage to the arithmetic logic unit a number of times 

before the entire processing is complete.  

▪​ After the completion, the results are sent to the output storage section and the output 

devices.  

 

o​  Storage Unit:- 

▪​ This is also called as Main Memory. Before the actual processing starts the data and the 

instructions fed to the computer through the input units are stored in this primary storage 

unit.  
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▪​ Similarly, the data which is to be output from the computer system is also temporarily 

stored in the primary memory.  

▪​ It is also the area where intermediate results of calculations are stored.  

 

STEP 6: KEY POINTS (5 minutes) 

●​ A computer is an electronic device that stores, retrieves, and processes data, and can be 

programmed with instructions.  

●​ A computer is very fast device. It can perform large amount of work in a few seconds. 

●​ The computer is 100% accurate and capable to perform arithmetical calculation and logic operations 

with the same accuracy 

●​ A computer can operate twenty four hours continuously without taking any rest.  

●​ Versatility is one of the most wonderful features about the computer. 

●​ Computer has made more memory or storage capacity than human beings.  

●​ Computers are automatic in operation and can be classified as:-Micro-computers, Minicomputers, 

Mainframe computer, Supercomputers 

●​ The basic components of computer system are:-Input Unit, Output Unit, Central Processing Unit and 

Storage Unit. 

 

STEP 8: Session Evaluation (5 minutes) 

●​ What is a computer? 

●​ What are Characteristics of a computer 

●​ How can computer be classified? 

●​ What are main parts of the computer? 
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SESSION 2:​ BASIC COMPUTER FUNCTIONS 

 

Total Session Time:​90 minutes 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time (min) Activity/​
Method 

Content 

1 05  Presentation Presentation of session title and learning tasks 

2 20 Buzzing/Presentation Distinctions between hardware and software 

3 20 Lecture Discussion Difference between computer application programs 

and operating systems 

4 10 Buzzing/Presentation Accessories of the computer 

 

5 25 Lecture Discussion Functions of computer parts and accessories 

 

6 05  Presentation Key Points 

7 05  Presentation Session Evaluation 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 
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ASK students if they have any questions before continuing 

STEP 2: Distinction of Computer hardware and software (20 Minutes) 

 

 

 

 

 

 

They are two parts of computer which are:- 

●​ Hardware computer is the collection of physical elements that constitutes a computer system.  

o​ Computer hardware refers to the physical parts or components of a computer such as the 

monitor, mouse, keyboard, computer data storage, hard drive disk (HDD), system unit (graphic 

cards, sound cards, memory, motherboard and chips), etc.  

o​ All of which are physical objects that can be touched.  

 

●​  Computer software is the set of programs that makes the hardware perform a set of tasks in 

particular order.  

o​ Hardware and software are complimentary to each other.  

o​ Both have to work together to produce meaningful results. 

o​ Computer software is classified into two broad categories; System Software and Application 

Software. 

STEP 3:  Difference between computer application programs and operating 

systems (15 Minutes) 

●​ System Software:- consists of a group of programs that control the operations of a computer 

equipment including functions like managing memory, managing peripherals, loading, storing, and is 

an interface between the application programs and the computer.  

o​ MS DOS (Microsoft’s Disk Operating System), UNIX are examples of system software. 

 

●​ Application Software:- Software that can perform a specific task for the user, such as word 

processing, accounting, budgeting or payroll, fall under the category of application software.  

o​ Word processors, spreadsheets, database management systems are all examples of general 

purpose application software 

 

 

 

. 
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 STEP 4: Accessories of the computer (10 Minutes) 

 

Activity: brainstorming (5 minutes) 

 

ASK students to brainstorm and list accessories of the computer. 

 

ALLOW  time for them to respond 

 

WRITE their response on the flip chart/board 

 

CLARIFY and SUMMARIZE by using the content below 

 

●​ Any device added to a computer that performs an additional feature, but is not required. 

●​ A good example of an accessory is the computer printer, which gives the computer the ability to 

print, but the computer would still work if it didn't have the printer.  

●​ Below is a listing of computer accessories:- 

o​ Printer 

o​ Mouse pad 

o​ Projector 

o​ MIDI Keyboard 

o​ Scanner 

o​ Speakers 

o​ Webcam 

o​ Joystick 

​  

STEP 5: Functions of computer parts and accessories (25Minutes) 

●​ The basic components of computer system are:- 

o​ Input Unit 

o​ Output Unit. 

o​ Central Processing Unit. 

o​ Storage Unit. 

 

o​ Input Unit 

▪​ Input devices are the devices which are used to feed programs and data to the computer.  

▪​ The input system connects the external environment with the computer system.  

▪​ The input devices are the means of communication between the user and the computer 

system. 

▪​ Typical input devices include the keyboard, floppy disks, mouse, microphone, light pen, joy 

stick, magnetic tapes etc.  

▪​ The way in which the data is fed into the computer through each of these devices is 

different.  

▪​ However, a computer can accept data only in a specific form.  

▪​ Therefore these input devices transform the data fed to them, into a form which can be 

accepted by the computer.  
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▪​ These devices are a means of communication and inter 1 station between the user and 

the computer systems. 

  

●​ The functions of the input unit are:- 

o​ Accept information (data) and programs 

o​ Convert the data in a form which the computer can accept. 

o​ Provide this converted data to the computer for further processing. 

 

o​ The Output Unit   

▪​ The output devices give the results of the process and computations to the outside world.  

▪​ The output units accept the results produced by the computer, convert them into a human 

readable form and supply them to the users.  

▪​ The more common output devices are printers, plotters, display screens, magnetic tape 

drives etc. 

 

o​ The Central Processing Unit. 

▪​ This is the brain of any computer system. The central processing unit or CPU is made of 

three parts:- control unit and arithmetic logic unit 

 

The control unit 

▪​ The Control Unit controls the operations of the entire computer system.  

▪​ The control unit gets the instructions from the programs stored in primary storage unit 

interprets these instruction an subsequently directs the other units to execute the 

instructions. 

▪​ Thus it manages and coordinates the entire computer system. 

 

The Arithmetic Logic Unit:- 

▪​ The Arithmetic Logic Unit (ALU) actually executes the instructions and performs all the 

calculations and decisions.  

▪​ The data is held in the primary storage unit and transferred to the ALU whenever needed.  

▪​ Data can be moved from the primary storage to the arithmetic logic unit a number of times 

before the entire processing is complete.  

▪​ After the completion, the results are sent to the output storage section and the output 

devices.  

 

o​  Storage Unit:- 

▪​ This is also called as Main Memory. Before the actual processing starts the data and the 

instructions fed to the computer through the input units are stored in this primary storage 

unit.  

▪​ Similarly, the data which is to be output from the computer system is also temporarily 

stored in the primary memory.  

▪​ It is also the area where intermediate results of calculations are stored.  

▪​ The main memory has the storage section that holds the computer programs during 

execution. Thus the primary units are:- 

●​ Stores data and programs during actual processing 

●​ Stores temporary results of intermediate processing 

●​ Stores result of execution temporarily 
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STEP 7: Key Points (5 minutes) 

●​ They are two parts of computer which are Hardware computer and Computer software  

●​ Hardware computer is the collection of physical elements that constitutes a computer system. 

●​ Computer software is the set of programs that makes the hardware perform a set of tasks in 

particular order 

●​ Computer software is classified into two broad categories; System Software and Application 

Software 

●​ Computer accessories are any device added to a computer that performs an additional feature, but 

is not required. 

●​ The basic components of computer system are:-Input Unit, Output Unit, Central Processing Unit and 

Storage Unit. 

 

STEP 8: Session Evaluation (5 minutes) 

●​ What are the difference between hardware and software? 

●​ What is the difference between computer application programs and operating systems? 

●​ What are computer  accessories ? 

●​ What are functions of computer parts and accessories? 
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SESSION 3:​ BASIC COMPUTER FUNCTIONS 

 

Total Session Time:​90 minutes 

 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time (min) Activity/​
Method 

Content 

1 05  Presentation Presentation of session title and learning tasks 

2 20 Presentation/Demonstration Perform computer connections and start up 

3 10 Lecture Discussion Graphical user interface(GUI) 

 

4 10 Buzzing/Presentation Computer file 

 

5 15 Presentation/Demonstration Performing  file management  

 

6 20 Presentation/Demonstration Transferring  file from computer to removable 

disks 

7 05  Presentation Key Points 

8 05  Presentation Session Evaluation 

 

SESSION CONTENTS 
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STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

STEP 2: Performing  computer connections and start up (20 Minutes) 

Steps in performing computer connections and start up. 

Place the computer on a flat surface near a grounded wall outlet. Your computer is designed to be 

placed on the floor to conserve desk space, but can place it on any stable, flat surface. 

Before you plug your computer into a wall socket, carefully read all the setup instruction in this user 

manual. 

Step 1:- Make sure the voltage switch on the back of the computer is set for the kind of voltage system 

to which you will be connecting. 

Step 2:- Plug the socket end of the computer’s power cord into the recessed power socket. 

Step 3:- Plug the other end of the power cord into a three-hole grounded outlet or power strip. 

Step 4:-Place the monitor near the computer. 

Step 5:-Connect the monitor power cord to the monitor. 

Step 6:- Plug the power cord into a grounded electrical socket or the back of the computer. 

Step 7:-Attach the monitor cable to the monitor, and then attach the monitor cable to the monitor port 

on the back panel of the computer. 

Step 8:- Connect the mouse and the keyboard to the computer. 

Step 9:- Turn on the computer and the monitor by press the power button. 

Step 10: The computer is working. 

Activity: Demonstration  (10 minutes) 

 

DIVIDE students into small manageable group  

 

DEMONSTRATE  to students on how to connect and start the computer using the steps below 

 

ALLOW  time for them to do return demonstrations 

 

. 
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 STEP 3: Graphical user interface(GUI) (10 Minutes) 

 

Activity: brainstorming (5 minutes) 

 

ASK students to brainstorm on GUI. 

 

ALLOW  time for them to respond 

 

WRITE their response on the flip chart/board 

 

CLARIFY and SUMMARIZE by using the content below 

 

●​ Graphical user interface is a form of user interface that allows users to interact with electronic 

devices through graphical icons and visual indicators such as secondary notation, instead of 

text-based user interface, typed command labels or text navigation. 

●​ Also, a graphical user interface (GUI) is a pictorial interface to a program.  
●​ A good GUI can make programs easier to use by providing them with a consistent appearance and 

with intuitive controls like pushbuttons, list boxes, sliders, menus, and so forth.  
●​ The GUI should behave in an understandable and predictable manner, so that a user knows what to 

expect when he or she performs an action. For example, when a mouse click occurs on a 

pushbutton, the GUI should initiate the action described on the label of the button. 
​  

STEP 4:  Computer file (15 Minutes) 

●​ Is an item that contains information for example, text or images or music  
●​ When opened, a file can look very much like a text document or a picture that you might 

find on someone's desk or in a filing cabinet 
●​ On a computer, files are represented with icons; this makes it easy to recognize a type of 

file by looking at its icon 
●​ A file is the common storage unit in the computer 
●​ All program and data are contained in a file 
●​ Computer reads and writes file 
●​ File extension enable user to recognize file.  
●​ It normally have three letter sequence  
●​ Some of the more common file extensions are as follows: 

o​ Microsoft Word.doc 
o​ Microsoft Excel.xls 
o​ Microsoft PowerPoint.ppt 
o​ Images .gif or .jpg 
o​ Video.mov or .mpg 
o​ Sound or Audio .mp3 or .wav 

 

 

STEP 5: Performing  file management (25Minutes) 

 

NMT 04104: Basic Computer Applications​  

 



​  

●​ A file management in a computer can be done through windows explorer or My Computer. 

●​ Windows Explorer displays the hierarchical list of files, folders, and storage drives (both fixed and 

removable) on your computer.  

●​ It also list any network drives that have been mapped to as a drive letters on your computer. 

Windows explorer can be used to copy, move, rename, and search for files and folders. For 

example, to copy a file, you can open a folder that contains the desired file to be copied or moved 

and then just drag and drop the file to target folder or drive.  Please see the figure 3.1.below. 

 

 

Figure 3.1:File Management 

Source: http://www.just.edu.jo/~mqais/CIS99/PDF/Ch.01_Introduction_%20to_computers.pdf. 

●​ When files or folders are deleted from hard disk, windows places them in the recycle bin, from 

where they can be retrieved, until the recycle bin is made empty.  

●​ Files or folders deleted from a removable storage media such as network drive are permanently 

deleted and not sent to the recycle bin. 

 

STEP 6: Transferring  file from computer to removable disks (20Minutes) 

Copying or moving a file or folder from computer to removable disk its involve the following 

procedure:- 

●​ Insert or plug the removable disk/ Flash or external drive in your computer. 

●​ Then, Click on Start, and the My Computer. 
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●​ Click the file or folder to be copied, if more than one file or folder can be copied at a time. 

●​ To select more than one consecutive files or folders, click the first file or folder, press and hold down 

SHIFT key and then click the files or folders. 

●​ And then select COPY . 

●​ Then find the name of removable flash or external drive, then OPEN it and PASTE those file or 

folder in your Flash drive. 

 

 

 

 

 

 

 

 

 

STEP 7: Key Points (5 minutes) 

●​ Place the computer on a flat surface near a grounded wall outlet 

●​ Graphical user interface is a form of user interface that allows users to interact with electronic 

devices through graphical icons and visual indicators  

●​ A file management in a computer can be done through windows explorer or My Computer 

 

STEP 8: Session Evaluation (5 minutes) 

●​ What are steps in computer connections and start up? 

●​ What is graphical user interface (GUI)? 

●​ What is Computer file? 

●​ How can you manage file in the computer? 

●​ How can you transfer file from computer to removable disks 
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SESSION 4:​ THE WORD PROCESSING APPLICATION 

 

Total Session Time:​60 minutes 

 

 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time 

(min) 

Activity/​
Method 

Content 

1 05 Presentation Presentation of session title and learning tasks 

2 20 Presentation/Demonstration 
Definition of  word processing 

application(Microsoft word) 

3 10 Lecture Discussion Features of Microsoft word 

4 15 
Lecture Discussion/ 

Demonstration 
Opening word processing application 

5 05 Presentation Key Points 

6 05  Presentation Session Evaluation 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 
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READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

STEP 2 •​ Definition of word processing application(Microsoft word) (10 

Minutes) 

 

Activity: brainstorming (5 minutes) 

 

ASK students to brainstorm on definition of word processing application 

 

ALLOW  time for them to respond 

 

WRITE their response on the flip chart/board 

 

CLARIFY and SUMMARIZE by using the content below 

 

●​ Microsoft Word is a word-processing application that can be part of the Microsoft Office suite or a 

stand-alone program installed on to your computer.  

●​ The program can be used to write letters and different types of documents that can include graphics 

and pictures.​ 
STEP 3:  Features of Microsoft word (15 Minutes) 

●​ An overview of Microsoft Word 2007 window. 

●​ If you’ve used previous version of Word you’ll notice that the old menu system has been replaced by 

the Ribbon and Office button. 
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Figure 4.1: Feature of the Ms word 

​ The Office button contains a menu of file-related commands. Click the Office 

Button to see the available commands. Select a command by clicking on it. 

​ The Quick access toolbar provides a set of frequently used commands. The 

default options are to save a file, to undo the last action, and to repeat your most 

recent action. 

​ The Ribbon tabs provide you with a set of tools that are relevant to what you are 

currently doing. In the example above, the Home tab contains formatting and 

editing options. 

​ The Title bar displays the name of the program and the name of the current 
document. If you haven’t named the document yet, then it will be called 
something like Document1. 

      Window controls are used to change the size of a window, or to close it. 

     ​ The Vertical scrollbar is used to scroll up and down the page. You can also click 
on the little down arrow below the scrollbar to move down the page. If your page 
is wider than the screen display, then you will also see a Horizontal scrollbar 
across the bottom of the window. 

​ The Status and information bar displays useful information about your 
document, such as the page count and number of words. 

STEP 4: Opening  word processing application (10Minutes) 

●​ To  OPEN your Microsoft Word here are steps:- 

o​ Click the Start button-the Start menu appears 

o​ Point to the entry for All Programs 

o​ Click on the entry for Microsoft Office-Word 2007 

 
 
 

 

 

 
 
Source: https://open.uct.ac.za/4162/CET_MSWord_2007_Manualv1.2.pdf?sequence=1 

 

 

 

NMT 04104: Basic Computer Applications​  

 

https://open.uct.ac.za/4162/CET_MSWord_2007_Manualv1.2.pdf?sequence=1


​  

 

 

 

 

 

 

STEP 5: Key Points (5 minutes) 

●​ Microsoft Word is a word-processing application that can be part of the Microsoft Office suite or a 

stand-alone program installed on to your computer.  

●​ Microsoft word has several features with commands such as Office button Quick access toolbar, 

Ribbon tabs, Title bar, Vertical scrollbar 

●​ To open Ms word you go on the start menu you click, point to the all programs and then click on the 

Microsoft Office –word 2007 

 

STEP 6: Session Evaluation (5 minutes) 

●​ What is the word processing application(Microsoft word)? 

●​ What are features of Microsoft word? 

●​ How can you open word processing application? 
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SESSION 5​ PREPARING DIFFERENT REPORTS USING WORD 

PROCESSING APPLICATION 

 

 

Total Session Time:​90 minutes 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time 

(min) 

Activity/​
Method 

Content 

1 05 Presentation Presentation of session title and learning tasks 

2 20 Presentation/Demonstration Opening  and save document 

3 40 Presentation/Demonstration Creating and formatting a word document 

4 15 Presentation/Demonstration 
Printing  document 

 

5 05 Presentation Key Points 

6 05  Presentation Session Evaluation 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 
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READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

 

STEP 2 • Opening  and saving  document (10 Minutes) 

●​ It is good practice to regular save your document as you are working on it. 

●​ This means that your document will be backed up on the computer in case your computer inexplicitly 

shuts down which would result in losing your document if it is not saved. 

●​ There are several ways to save a document in word.  

●​ The following instructions will take you     through the different options:-​ 
 

Step 1: If you are saving a document for the first time, on the ‘Quick Access Toolbar’, 

             Click ‘Save’  , or press ‘CTRL+S’. 
 
 

 

 

 

 

NMT 04104: Basic Computer Applications​  

 



​  

 

 

 

 

 

 

 

 

 

 

 

Step 2: Type a name for the document and then click “save” Word saves the document in a 
default location. To save the document in a different location, select another folder in the list 
of folders. 
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Activity: Demonstration  (10 minutes) 

 

DIVIDE students into small manageable group  

 

DEMONSTRATE  to students on how to open and save a word document 

ALLOW  time for them to do return demonstrations 

 

STEP 3:  •​ Creating  and formatting a word document (40 Minutes) 

●​ An overview of Microsoft Word 2007 window. 

●​ If you’ve used previous version of Word you’ll notice that the old menu system has been replaced by 

the Ribbon and Office button. 

 

 
 

 

 

 

 

 

 

 

Figure 4.1: Feature of the Ms word 

​ The Office button contains a menu of file-related commands. Click the Office 

Button to see the available commands. Select a command by clicking on it. 

​ The Quick access toolbar provides a set of frequently used commands. The 

default options are to save a file, to undo the last action, and to repeat your most 

recent action. 

​ The Ribbon tabs provide you with a set of tools that are relevant to what you are 

currently doing. In the example above, the Home tab contains formatting and 

editing options. 
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​ The Title bar displays the name of the program and the name of the current 
document. If you haven’t named the document yet, then it will be called 
something like Document1. 

      Window controls are used to change the size of a window, or to close it. 

     ​ The Vertical scrollbar is used to scroll up and down the page. You can also click 
on the little down arrow below the scrollbar to move down the page. If your page 
is wider than the screen display, then you will also see a Horizontal scrollbar 
across the bottom of the window. 

​ The Status and information bar displays useful information about your 
document, such as the page count and number of words. 

STEP 4: Opening  word processing application (10Minutes) 

●​ To  OPEN your Microsoft Word here are steps:- 

o​ Click the Start button-the Start menu appears 

o​ Point to the entry for All Programs 

o​ Click on the entry for Microsoft Office-Word 2007 

 
 
 

 

 

 
 
Source: https://open.uct.ac.za/4162/CET_MSWord_2007_Manualv1.2.pdf?sequence=1 

 

 

Activity: Demonstration  (5 minutes) 

 

DIVIDE students into small manageable group  

 

DEMONSTRATE  to students on how to open MS WORD 

ALLOW  time for them to do return demonstrations 

 

 
STEP 5: Creating  and formatting  a word document (20Minutes) 

Copying or moving a file or folder from computer to removable disk its involve the following 

procedure:- 

●​ Insert or plug the removable disk/ Flash or external drive in your computer. 
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●​ Then, Click on Start, and the My Computer. 

●​ Click the file or folder to be copied, if more than one file or folder can be copied at a time. 

●​ To select more than one consecutive files or folders, click the first file or folder, press and hold down 

SHIFT key and then click the files or folders. 

●​ And then select COPY . 

●​ Then find the name of removable flash or external drive, then OPEN it and PASTE those file or 

folder in your Flash drive. 

 

 

 

Activity: Demonstration  (10 minutes) 

 

DIVIDE students into small manageable group  

 

DEMONSTRATE  to students on how to transfer file from the computer to the removable device 

ALLOW  time for them to do return demonstrations 

 

STEP 7: Key Points (5 minutes) 

●​ Microsoft Word is a word-processing application that can be part of the Microsoft Office suite or a 

stand-alone program installed on to your computer.  

●​ Microsoft word has several features with commands such as Office button Quick access toolbar, 

Ribbon tabs, Title bar, Vertical scrollbar 

●​ To open Ms word you go on the start menu you click, point to the all programs and then click on the 

Microsoft Office –word 2007 

 

STEP 8: Session Evaluation (5 minutes) 

●​ What is the word processing application(Microsoft word)? 

●​ What are features of Microsoft word? 

●​ How can you open word processing application? 
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SESSION 6:​ USING THE MICROSOFT EXCEL APPLICATION. 

 

Total Session Time:​90 minutes 

 

 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

SESSION OVERVIEW  

Step Time 

(min) 

Activity/​
Method 

Content 

1 5 Presentation Presentation of session title and learning tasks 

2 5  Presentation Definition of term Microsoft Excel 

3 5 Presentation Features of Microsoft Excel  

4 20 Presentation, Demonstration 
Opening  spread sheet application  

 

5 20 Presentation/demonstration Entering data in excel worksheet  

6 20 Presentation/demonstration Performing simple calculation  

7 20 Presentation/demonstration Manipulating data  

8 20 Presentation/demonstration Making charts and tables  
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9 05 Presentation Key Points 

10 05  Presentation Session Evaluation 

 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (05 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

 

STEP 2 • Definition of Microsoft Excel  (05 Minutes) 

●​ Microsoft Excel is a general-purpose electronic spreadsheet used to organize, calculate, and 

analyze data.  

●​ The tasks you can complete with excel ranges from preparing a simple family budget, preparing a 

purchase order.  

●​ Excel is all about number! There’s almost no limit to what you can do with numbers in excel, 

including sorting, advanced calculations, and creating graphs 

●​ Active Cell: - is the selected cell in which data is entered when you begin typing. Only one cell is 

active at a time. The active cell is bounded by a heavy border. 

●​ Formula Bar:- is a bar at the top of the excel window that you use to enter or edit values or 

formulas in cells or charts. 

●​ Workbook: - is a spreadsheet program file that you create in excel. A workbook contains 

worksheet of rows and columns in which you can enter and calculate data. 

●​ Worksheet: - is a primary document that you use in excel to store and work with data. Sometime is 

called a spreadsheet. A worksheet consists of cells that are organized into columns and rows; a 

worksheet is always stored in a workbook. 

●​ Name box: - is a box at left end of the formula bar that identifies the selected cell, chart item, or 

drawing object. To name a cell or range, type the name in the name box and press ENTER. To 

move to and select a named cell, click its name in the Name box.  

●​ Cell: - is a box formed by the intersection of a row and column in a worksheet or a table, in which 

you enter information. 

●​ Cell reference: - is a set of coordinates that a cell occupies on a worksheet. For example, the 

reference of cell that appears at the intersection of column B and Row 3 is B3. 

●​ Column: - is a field that’s assigned in a Pivot Table. 
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STEP 3 • Features of Microsoft Excel  (05 Minutes) 

In the Excel window the title bar display the name of your current workbook. Tabs at the bottom of the 

screen identify the different worksheet available to you. 

 

 

 

 

 

 

 

 

 

 

 

STEP 4 • Opening  Microsoft Excel  (20 Minutes) 

 

 

 

 

 

 

 

 

●​ Steps of opening Microsoft Excel here are:- 

o​ Click the Start button-the Start menu appears 

o​ Point to the entry for All Programs 

o​ Click on the entry for Microsoft Office-Excel 
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STEP 5: Entering data in Excel Worksheet  (20 Minutes) 

 

 

 

 

 

 

 

 

To enter numbers or texts in excel worksheet these are procedure:- 

●​ Click on the cell where you want the data to be stored, so that the cell becomes active. 

●​ Type the number or text. 

●​ Press ENTER to move the next row, or TAB to move to the next column. 
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STEP 6: Performing Simple calculations (20 Minutes) 

 

 

 

 

 

 

 

 

Formulas and Functions 

Cells can contain formulas and functions that calculate cell values. In our example, SUM(B2:D2) adds 

the value of each cell in cell in cell range B2:D2 and display the total in cell E2. 

 

 

 

 

 

 

 

STEP 7: Manipulating data  (20 Minutes) 

 

Now let’s look at some of the rules for creating 

formulas. The operators that you need to know are: 

+           Addition 
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–           Subtraction 

 

*           Multiplication 

 

/           Division 

 

^           Exponentiation (“to the power of”) 

 

&          to join two text strings together 

 

Some basic function most commonly used function include:- 

         SUM ()              To calculate the total of a set of numbers 

         AVERAGE ()      To calculate the average of a set of numbers. 

         MAX ()              To calculate the maximum value within a set of numbers MIN () 

 

AVERAGE =AVERAGE (E2/3) 

TOTAL= SUM (A2:D2) 

RESULT =IF (F2>80,"A", IF (F2>75,"B+", IF (F2>65,"C","FAIL"))) 

 

 

 

STEP 8: Making Charts and tables (10 Minutes) 
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Creating a chart. 

Its very easy to create a basic chart in MS Excel:- 

1.​ Select the data that you want to include in the chart (together with column headings if you have 

them). 

On the Insert tab, find the Chart group and select your preferred chart type 

 

 

 

 

 

 

 

That’s it! The chart appears in the current window. Move the cursor over the chart area and drag it to a 

new position. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Modifying a chart 

When you click on a chart, a chart tools section appears with Design, Layout and Format tabs. 

In the example below, I’ve used different option to change the chart type to Column and swapped the 

rows and columns. All it took was four mouse clicks! 
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STEP 9: Key Points (5 minutes ) 

●​ Microsoft Excel is a general-purpose electronic spreadsheet used to organize, calculate, and 

analyze data.  

●​ The tasks you can complete with excel ranges from preparing a simple family budget, preparing a 

purchase order.  

●​ Excel is all about number! There’s almost no limit to what you can do with numbers in excel, 

including sorting, advanced calculations, and creating graphs 

●​ Active Cell: - is the selected cell in which data is entered when you begin typing. Only one cell is 

active at a time. The active cell is bounded by a heavy border. 

●​ Formula Bar:- is a bar at the top of the excel window that you use to enter or edit values or 

formulas in cells or charts. 

●​ Workbook: - is a spreadsheet program file that you create in excel. A workbook contains 

worksheet of rows and columns in which you can enter and calculate data. 

 

STEP 10: Evaluation (05 minutes) 

What is worksheet?  
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What is cell? 

What is column?  
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SESSION 7:​ USING THE MICROSOFT POWER POINT APPLICATION 

 

Total Session Time: 60 minutes 

 

 

 

 

 

 

 

 

 

 

SESSION OVERVIEW  

Step Time 

(min) 

Activity/​
Method 

Content 

1 5 Presentation Presentation of session title and learning tasks 

2 5  Presentation Definition of term Microsoft powerPoint 

3 5 Presentation Features of Microsoft powerPoint 

4 20 Presentation/Demonstration 
Creating slide for presentation  

 

 15 Presentation/Demonstration 
Performing PowerPoint presentation 

 

5 5 Presentation Key Points 

6 5  Presentation Session Evaluation 

 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 
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STEP 2 • Definition of Microsoft powerPoint (05 Minutes) 

●​ Power Point” refers to Microsoft Power Point, a program that allows the user to design a 

presentation that consists of multiple slides.  

●​ These slides may contain images, text, video clips, and related of information. 

●​  Power point is useful for delivering a speech, because the user can utilize text on the screen to 

remind him or herself of the information to be conveyed to the audience or to summarize his/her 

dialogue into more manageable and “friendly” sizes, as well as to entertain or explain graphs, 

charts, and related data 

 

STEP 3 • Features  of Microsoft powerPoint (05 Minutes) 

 

The basic features of Microsoft Power Point are:- 

 

 

 

1. Title Bar- Displays the name of the application followed by the title of the presentation 

2. Formatting Toolbar:-Provides quick access to commands you need for formatting. 

3. Outline and Slides Tab: - The slides tab gives you a thumbnail view of all the slides in the 

presentation and allows to rearrange their order; the outline tab adds textual content to the slides in an 

outline format. 

4. Slide Pane- Area where you build the slide for your presentation. 

5.View Buttons- Change the way you view the presentation; the Normal view (left button) is the 

default, the Slide sorter view (center button) shows you only the thumbnails and is used to sort and 
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rearrange the presentation, and the run view (right button) runs the presennntation from the current 

slide 

6. Drawing Toolbar- Provide all the tools you need to draw and format object. 

7. Notes Pane- Adds notes for yourself for each slide in your presentation 

 

 

STEP 4 • Creating a New presentation  (20 Minutes) 

 

 

 

 

 

 

 

 

 

 

Using the AutoContent Wizard 

1. If necessary, choose File > New to display the New Presentation pane 

2. On the New Presentation pane, click on the AutoContent Wizard link 

You will be walked through a series of question a about the presentation you are making, including 

a category for the type of information being presented and the method of delivery. 

 

Using a Design Template 

 1. If necessary, choose File > New to display the New Presentation pane. 

2. On the New Presentation pane, click on the from design Template link 

3. The Slide Design pane will display on the right side of the screen with a variety of different 

templates to choose from. 

4. Select the design of your choice from the slide Design pane. 

5. Click OK to begin working with the first slide in the Normal View. 

 

 

STEP 5 • Perform Power Point presentation. (15 Minutes) 
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On the Slide Show tab, in the Start Slide Show group, select From beginning. 

Now, if you are working with Power Point on a single monitor and you want to display Presenter view, in 

Slide Show view. On the control bar at the bottom left, then select Show Presenter View. 

 

STEP 9: Key Points (5 minutes ) 

●​ Power Point” refers to Microsoft Power Point, a program that allows the user to design a 

presentation that consists of multiple slides.  

●​ These slides may contain images, text, video clips, and related of information. 

●​  Power point is useful for delivering a speech, because the user can utilize text on the screen to 

remind him or herself of the information to be conveyed to the audience or to summarize his/her 

dialogue into more manageable and “friendly” sizes, as well as to entertain or explain graphs, 

charts, and related data 

●​ . 

 

STEP 10: Evaluation (05 minutes) 

What  are the features of Microsoft PowerPoint?  
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   SESSION 8:  USING THE MICROSOFT PUBLISHER APPLICATION 

 

Total Session Time: 60  minutes 

. 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time 

(min) 

Activity/​
Method 

Content 

1 5 Presentation Presentation of session title and learning tasks 

2 5  Presentation Definition of term Microsoft publisher 

3 5 Presentation Features of Microsoft publisher 

4 20 Presentation/Demonstration 
Designing  brochures, flyers and posters 

 

5 15 Presentation/demonstration 
Printing brochures flyers and posters 

 

6 5 Presentation Key Points 

7 5  Presentation Session Evaluation 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 
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STEP 2 • Definition of Microsoft publisher (05 Minutes) 

Microsoft Publisher 2007 is a desktop publishing program that can be used to create a variety of 

publications. Using Publisher, you easily create business cards, greeting cards, calendars, newsletters 

and much, much more. 

STEP 3 • Features  of Microsoft publisher (05 Minutes) 

●​ Frame – Most publications are divided into several different areas called frames. A frame can 

contain a variety of objects such as graphics, tables, or text boxes. Frames can be resized, moved 

and manipulated to suit your needs. 

●​ Handles – When you click on a frame, small circles appear around the edge of the frame. 

These are called handles. You can click and drag on the handles to resize your frame. 

​ Picture Frame 

 

​ Handles​ Text Frame 

 

 

 

 

 

Template ‐ A Template is a tool used in Publisher to help you easily create basic publications. 

The template has a set of pre‐chosen design styles that you can use as it is or customize as 

you see fit. 

STEP 4 • Opening Publisher (20 Minutes) 

 

 

 

 

 

To Open Publisher either: 

Double click on the Microsoft Publisher Icon on your desktop, OR 

‐OR 

Click on Start in the lower left hand corner of your desktop, move up to 

Programs and then click on Microsoft Publisher. 
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STEP 5 • Design Calendar, Business card and Posters. (15 Minutes) 

 

 

 

 

 

 

 

 

 

1.​ When you first open Publisher, Publisher offers you a number of different publication types 

to start with. 

2.​ Click on one of the publication types in the main window or in the list on the left side of the 

main window to view a list of templates that will walk you through the process of making basic 

design choices for your publication. These choices include color schemes, font styles, and 

more. 

To Create a Calendar: 

1.   Open Microsoft Publisher by double clicking the icon on the desktop or finding it 

under the start menu. 

 

2.   Click on Calendars from the main window or the list on the left. A selection of pre‐ 
designed templates appears for you to choose from. 

 

3.   Click on one of the pre‐designed templates that you like. It will appear at the top of the 

area on the right side of the page. 

 

4.   You can either stick with the default design choices that are part of the template, or you 

can customize them by clicking the downward pointing arrow to the right of a design section 

and choosing any of the options provided by clicking on it. 

 

5.   Click on the Set Calendar Dates button and choose the period of time that you 

would like your calendar to cover. 

 

6.   Click on Create at the bottom to create your calendar. 

Creating a Business Card 

1.   Open Microsoft Publisher by double clicking the icon on the desktop or   finding it 

under the start menu. 

2.   Click on Publications for Print then Business Cards, and finally Accent Box 

Business Card. 
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3.   In the personal information form that opens, enter your 

own contact information and click on OK. (If you 

accidentally close your personal information and you 

want to edit it further, click on the Edit Menu and 

Personal Information to retrieve the form.) 

4.   In the task pane on the left side of the window, you are 

given different options you can adjust. As you click on 

the different steps at the top of the task pane, the 

options change on the lower part of the task pane. 

5. Click on Business Card 

Options.  

a.   Choose to include a 

logo. 

b.   Choose the traditional Landscape 

c.   Choose to have multiple copies 

per sheet 

6.   Click on Publication Designs. 

a.   Leave the selected Accent Box. 

b.   Click on Color Schemes and select the desired color scheme. 

1.​ Click on Font Schemes and select the desired font scheme. 

Saving your publication 

               There are two basic ways to save your publication 

 

Point and click on the save icon        on your toolbar, or 

 

‐OR 

 

1.    Click on the File Menu and Save As. 

 

2.​ When the Save As Dialogue Box appears Click Browse and find the 

location on your computer where you would like the file saved. 

 

3.    Type the name of your publication in the File Name field. 

 

4.  Click on the Save 

●​ Print calendar, business card and posters. 

There are two basic ways to print your publication: 

Click on the print icon on your toolbar             . This will print one copy of your 

publication with the default print options. 

 

 1. Click on the File Menu and click Print. 
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2. When the print window appears, select the desired number of copies and choose any 

other printing options you want. 

3.  Click OK. 

STEP 6: Key Points (5 minutes ) 

To create calendar Open Microsoft Publisher by double clicking the icon on the desktop 

or finding it under the start menu. 

 

Click on Calendars from the main window or the list on the left. A selection of pre‐ 
designed templates appears for you to choose from. 

 

Click on one of the pre‐designed templates that you like. It will appear at the top of the area 

on the right side of the page. 

 

You can either stick with the default design choices that are part of the template, or you can 

customize them by clicking the downward pointing arrow to the right of a design section and 

choosing any of the options provided by clicking on it. 

 

Click on the Set Calendar Dates button and choose the period of time that you would 

like your calendar to cover. 

 

Click on Create at the bottom to create your calendar. 

 

STEP 7: Evaluation (05 minutes) 

●​ What is Microsoft publisher? 

●​ What are features of Microsoft Publisher? 

●​ How can you Design brochures, flyers and posters? 

●​ How can you Print brochures flyers and posters in publish? 

 

NMT 04104: Basic Computer Applications​  

 



​  

References 

Coletti, P. (2015). Basic Computer Course Book. Retrieved on March 13, 2015, through 
www.paolocoletti.it/books/basiccomputer.pdf  

EZ-REF Courseware (2007). Microsoft Office 2007 Training Manual. Retrieved on March 13, 
2015, through 
http://s3.amazonaws.com/szmanuals/2f0785413c6ff4c31aa813c27f5d88a8  

Goss, T. (2009). What is an entity in MS access. Retrieved from http://www.brighthub.com 
Helium. (2002). How to sort a range of data in Microsoft excel. Retrieved from 

http://www.computer-softeware.helum.com 
InfoPackets. (2006). Insert rows and columns in tables: MS word. Retrieved from 

http://www.infopackets.com 
Microsoft-Lynchburg College Office Tutorials. (2006). Creating a database using access 

2007. Retrieved from http://www.officetutorials.com 
Microsoft Support. (2004). How to: Open Microsoft access 2000 to a specific form by using a 

shortcut. Retrieved from http://www.support.microsoft.com 
Tools for SEO. (2012). Introduction to MS-Word. Retrieved from www.nos.org/htm/ms- 

word1.htm 
University of California-Berkley Library. (2012). Tutorial table of contents. Retrieved from 

http://www.lib.berkeley.edu 
University of Texas at Austin. (2004). Getting started with Microsoft access. Retrieved from 

http://www.utexas.edu 
Waverka, P. (2003). Office 2003 all in one desk reference for dummies. New Jersey: Wiley 
​
​
 

 

 

 

NMT 04104: Basic Computer Applications​  

 

http://s3.amazonaws.com/szmanuals/2f0785413c6ff4c31aa813c27f5d88a8
http://www.brighthub.com
http://www.computer-softeware.helum.com
http://www.infopackets.com
http://www.support.microsoft.com
http://www.nos.org/htm/ms-%20word1.htm
http://www.nos.org/htm/ms-%20word1.htm


​  

ESSION 9:  USING THE MICROSOFT ACCESS APPLICATION. 

 

Total Session Time: 120 minutes 

. 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time 

(min) 

Activity/​
Method 

Content 

1 05 Presentation Presentation of session title and learning tasks 

2 5  Presentation 

Definition of  the terms used in Microsoft access 

(database, report, data, table, field)  

 

3 10 Presentation 
Features of Microsoft access 

 

4 20 Presentation/Demonstration 
Opening and Creating  simple data base 

 

 20 Presentation/demonstration 
Entering  data into a simple created database 

 

 20 Presentation/demonstration 
Creating  simple report from a database 

 

5 05 Presentation Key Points 

6 05  Presentation Session Evaluation 
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SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (5 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

 

STEP 2 • Definition of Microsoft access (database, report, data, table, field) (05 

Minutes) 

●​ Database: - is a collection of information that’s related. Access allows you to manage your 

information in one database file. 

●​ Tables: - are the one which store data in your database. 

●​ Queries: - is the way you ask question about information stored in your tables. 

●​ Forms: - are the one which allow you to view data stored in your tables. 

●​ Reports: - are the one which allow you to print data based on queries/ tables that you have 

created. 

 

STEP 3: Features of Microsoft Access (10  minutes) 
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STEP 4: Opening and Creating Simple Dtatabase  (20 minutes) 

 

 

 

 

 

 

 

1)​ Start Access 

 

 

2) Select Blank Database 

3) In the file Name Field enter a name for the database 

4) Click Create 

Microsoft Access automatically create a new table in the database called Table 1.This is a temporary 

name until the table is saved. 
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STEP 5:Entering Data into a Simple Created Database (20 minutes) 

 

 

 

 

 

Entering data in a table 

1) Make sure you are in Database View 

2) Enter the data into the table by pressing the tab key to move from one cell to another. 

3) When you have completed the record (row), press ENTER. 

 

When inputting data into the table, Access automatically saves the data after each new record. 
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STEP 6: Creating Simple Report from a Database (20 minutes) 

 

 

 

 

 

 

Reports can be based on tables or queries and can be made with the report wizard. 

 To Create a Report Using the Report Wizard:- 

1)​ Click the Create tab on the Ribbon 

2)​ Click the Report Wizard icon 

3)​ Select the table or query upon which the report will be based 

4)​ Select the fields that you want to include on the report by double clicking on them 

5)​ Click Next 

6)​ If  you would like to add grouping to your report, select the field you wish to group by double 

clicking on it (Example: City) 

7)​ Click NEXT 

8)​ Select a style for the report 

9)​ Click NEXT 

10)​ Type a title for the report 

11)​Click Finish 

 

STEP 7: STEP 6: Printing  Report from a Database (20 minutes) 

 

 

 

 

 

 

 

To Print a Report 

1)​ Click the Print Icon on the Print Preview Ribbon 

2)​ Select the Printer 

3)​ Click OK. 
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STEP 8: Key Points (5 minutes ) 

●​ Database: - is a collection of information that’s related. Access allows you to manage your 

information in one database file. 

●​ Tables: - are the one which store data in your database. 

●​ Queries: - is the way you ask question about information stored in your tables. 

●​ Forms: - are the one which allow you to view data stored in your tables. 

●​ Reports: - are the one which allow you to print data based on queries/ tables that you have 

created. 

 

STEP 9: Evaluation (05 minutes) 

●​ What  are the features of Microsoft Access Aplication?  
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SESSION 10: USING BASIC COMPUTER OPERATION TO SEARCH 

HEALTH INFORMATION. 

 

Total Session Time: 120 minutes 

 

. 

 

 

 

 

 

 

 

Resources Needed: 

●​ Flip charts, marker pens, and masking tape 

●​ Black/white board and chalk/whiteboard markers 

●​ LCD Projector and computer 

●​ Note Book and Pen 

 

Step Time 

(min) 

Activity/​
Method 

Content 

1 05 Presentation Presentation of session title and learning tasks 

2 5  Presentation 

Definition common terms used in computer 

communication(computer network, internet and 

email) 

 

3 10 Brainstorming, Presentation Importance of using e-mail in communication  

4 15 Presentation 
Different search engine and online database 

used to search health information  

 25 Presentation/demonstration 

Searching  health information using search 

engines and online databases(Google, WHO and 

MOHCDGEC database) 
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 30 Presentation, Demonstration  Creating and email account and sending email  

 20  Sending an email  

5 05 Presentation Key Points 

6 05  Presentation Session Evaluation 

 

 

SESSION CONTENTS 

STEP 1: Presentation of Session Title and Learning Objectives (05 minutes) 

READ or ASK students to read the learning objectives 

ASK students if they have any questions before continuing 

 

STEP 2 • Definition common terms used in computer communication(computer 

network, internet and email) (02 Minutes) 

●​ Computer: - is an electronic device that stores, retrieves, and processes data, and can be 

programmed with instructions. And it’s designed to perform arithmetic and logical operations 

automatically. 

●​ Network: - is a group of computers and other devices connected in some ways so as to be able to 

exchange data. 

●​ Internet:- is a network of networks that consists of millions of private, public, academic, business, 

and government networks, of local to global scope, that are linked by a broad array of electronic, 

wireless and optical networking technologies. 

●​ E-mail:- is a paperless method of sending messages, notes, or letters from one person to another 

or even many people at the same time via Internet. 

 

STEP 3• Importance of using e-mail in communication (10 Minutes) 

 

 

 

 

 

 

 

●​ Cheap- sending an email costs the same regardless of distance and the number of people you 

send it to. 
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●​ Fast- an email should reach its recipient in minutes, or at the most within a few hours. 

●​ Convenient- your message will be stored until the recipient is ready to read it, and you can easily 

send the same message to a large number of people 

●​ Permanent- you can keep a record of message and replies, including details of when a message 

was received. 

 

STEP 4• Different Search Engine and Online Database used to Search Health 

Information (15 Minutes) 

 

●​ Pub Med is probably the first online search engine that comes to  mind for health writers.  

●​ It is a free online archive of medical journal articles maintained by the United States National 

Institutes of Health’s National Library of Medicine (NLM). 

●​ Ovid is a comparable search engine to Pub Med. Its advantage over Pub Med is it searches 

more database in addition to MEDLINE, including EMBASE and the Cochrane Database of 

Systematic Reviews (CDSR). 

●​ Web of Science is a large database to search for scholarly research data on emerging trends 

if you’re writing protocols or guidelines. It covers over 250 disciplines in science, social science, 

arts and humanities. 

●​ Science Direct is a full text scientific database, which can really help you writing when you 

need to read more than abstract. 

●​ Scopus is a large database of over 60 million peer-reviewed literature also owned by Elsevier. 

Scopus interfaces with the EMBASE and MEDLINE database to search records for journal 

article. 

●​ Cochrane Library is a subscription-based search platform where database of systematic 

reviews of MEDLINE and EMBASE, Cochrane protocols are included. 

●​ Google Scholar is a free medical journal search engine indexing journal articles from a variety 

of database. If you regularly use Google to search online, using Google Scholar will come quite 

naturally and you can easily navigate and filter the result to suit your search. 
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STEP 6: Searching  Health Information Using Search Engines And Online 

Databases (Google, WHO And MOHCDGEC Database) (25 minutes) 

 

 

 

 

 

 

 

 

 

●​ Open the browser 

●​ Typing any search engine  

●​ Open the health information.  

●​ Type what you want to search  

 

STEP 6: Creating email account (30 minutes) 

 

 

 

 

 

 

 

 

Steps of open an email account  

Step 1: Open the internet explorer and type the address: http://www.google.com. You should arrive to a 

screen that looks like this: 
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Step 2: Click on the link near the top of the page that says, “Gmail”. 

 

Step 3: Click on the gray button in the right hand corner of the screen that says, “Create an account”. 

 

NMT 04104: Basic Computer Applications​  

 



​  

 

Step 4: Type in your first and last name in the appropriate boxes. If your are uncomfortable using your 

real name you can make one up. In the box next to “Desired Login Name”, you will type what you want 

to be your e-mail name. This can be your first and last name or a nickname or anything else. It MUST 

be at least 6 letters or characters long. Once you’ve typed it in the box click on the gray button that 

says, “Check Availability”. 

 

If your name is already taken this screen will appear, don’t panic. 
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Try typing some number after your name until your screen says your name was available. 

Step 5: Now you must create a secret word so that only you can access your e-mail account. It has to 

be at least eight letters/characters long and can include numbers and capitalized letters. The password 

strength means that your word is hard for someone to guess. The way you can increase the strength is 

by using a number or capital letter. A combination of these two things in your password creates the 

maximum strength. 

Example: 

Password:                    Strength: 

Librariesrock                Weak 

LibrariesRock               Medium 

LibrariesRockx10         Strong 

 

 

 

****REMEMBER: Password is case sensitive, meaning if you use a capital letter in your password then 

you must always remember to capitalize the letter when entering your password. 

 

 

Step 6: Now we have to make a secret question and answer. This in case you forget your password, 

then Gmail will be able to know its you and give it to you. 

Select one of the question and type in an answer that only you’ll know and remember. 
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Your screen should now look something like this: 

 

 

Doesn’t worry if you don’t have another e-mail address; just leave the “Secondary email” box blank. 

 

Step 7: Now scroll down the page and your screen should look something like this:- 

 

NMT 04104: Basic Computer Applications​  

 



​  

 

 

Select the location you currently living in with the drop down tab. Then fill out the “Word 

Verification” part. 

Just type the letters and numbers shown in the picture box into the white box. The letters are not 

case sensitive, meaning it doesn’t matter if you capitalize it or not 

Once you have typed in the “Word verification” box, browse through the “Terms of Services”. 

 

Once you get to the end of the “Term of Services” information click the gray button that says, “I accept. 

Create my account”. 
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This page should then appear:- 

 

This gives you a few informative things that are unique to this particular e-mail account. 

 

Click the “I’m ready- show me my account” button and then you’ll view your e-mail account: 
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Congratulations you have successfully created your own e-mail account!!!... 

STEP 7: Sending email  (20 minutes) 

  

       Follow these step-by-step instructions to send an e-mail  

Step 1: Log in to your email account so that you are on the dashboard (front page) of you mail 

account. 

Step 2: Click Compose. Alternative, you can reply to an email that you’ve received by 

double-clicking on it in your list of received emails, then following the same steps. 

 

 

Once you clicked on the button, a new small window will open. 
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STEP 3: “To” field is placed at the top of the new window where you have to enter the email 

address of the recipient to which you want to send your email. You can also add more than one 

recipient here. 

STEP 4: At the right corner of “To” field, you can see a “Cc” and Bcc” links. Now you are thinking 

that how can we use these links and what is the use of these links. 

   Cc:-recipients can be add to a message for informational needs only. If you don’t want any 

respond from the recipients then you can add those recipients in “Cc”. 

   Bcc:-stands for blind copy. When you add a recipient in Bcc then the sent blind copy of message 

can be seen by you and that person only. 

STEP 5: In “Subject” field, you have to add few words about your message. 

STEP 6: Now you are ready to build your message in the next field. 

STEP 7: You can attach any file by clicking the paperclip icon. 

STEP 8: At last, click on the “SEND” bottom which is at the bottom and your message will be send. 

 

Attaching a file to an e-mail. 

STEP 1: Type in the web addresses of your email host in the address bar and log onto your email 

account. 

 

 

STEP 2: Click on “Compose” to write a new email. 
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STEP 3: Click on the icon to attach a file. This icon appears as a paperclip symbol in most email 

programs. After you click on the icon to attach a file a box will pop up onto your screen. 

 

 

STEP 4: Browse the information on your computer my clicking on the folder that contain the file that you 

would like to attach. When you find the needed file, click on it and then click on “open”. This will start 

the process of attaching the file to your outgoing email message. 

 

STEP 5: Read the direction on your computer screen. It will most likely say that the file was attached 

successfully. 
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STEP 6: Write the text of your email, insert your recipient’s email address and then click on “send”. 

 

STEP 8: Key Points (5 minutes ) 

Importance’s of an email are Cheap, Fast, Convenient and Permanent  

Network: - is a group of computers and other devices connected in some ways so as to be able to 

exchange data. 

Internet:- is a network of networks that consists of millions of private, public, academic, business, and 

government networks, of local to global scope, that are linked by a broad array of electronic, wireless 

and optical networking technologies. 

E-mail:- is a paperless method of sending messages, notes, or letters from one person to another or 

even many people at the same time via Internet. 

 

STEP 9: Evaluation (05 minutes) 

●​ What are the searching engine online databases used to search health information?  
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